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AKVIS ENHANCER 17.5 | ФОТОКОРРЕКЦИЯ С УСИЛЕНИЕМ ДЕТАЛИЗАЦИИ

AKVIS Enhancer — программа для обработки фотографий, предназначенная для  улучшения детализации снимка,
коррекции затемненных областей, повышения резкости границ и контрастности изображения.

Очень часто фотография кажется безнадежно испорченной, слишком темной, нечеткой. Причины могут быть разные, и
во многих случаях дело поправимо.

AKVIS Enhancer (название программы переводится как "улучшатель") помогает во многих трудных случаях.

Программа работает в трех режимах: Улучшение деталей, Допечатная обработка и Тоновая коррекция. Задача
режимов одна — коррекция, но способы исправления изображения, а, соответственно, и результаты — разные. Для
разных изображений и разных целей подойдут разные режимы обработки, а в некоторых случаях можно использовать
поочередно все.

Режим Улучшение деталей обеспечивает комплексную коррекцию каждой точки изображения без потери качества,
позволяет проявить детали в светлых и темных областях. В этом режиме программа улучшает текстуры, подчеркивает
детали, "вытаскивая" их из засвеченных и затемненных областей. Enhancer исправляет недодержанные фотографии,
снимки, сделанные против солнца, и даже помогает избавиться от тумана или дымки.

Режим Допечатная обработка помогает подготовить изображение перед печатью или публикацией в сети. При работе
в данном режиме повышается резкость границ и контрастность всего изображения. Даже качественные фотографии
рекомендуется обрабатывать в этом режиме, в результате изображения приобретают профессиональный вид.

Режим Тоновая коррекция предназначен для изменения яркости пикселов в темных и светлых областях, за счет чего
улучшается общая картина. Этот режим позволяет откорректировать не только все изображение, но и отдельные
цветовые области (например, осветлить только портрет, оставив фон нетронутым, или затемнить пересвеченное небо).
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AKVIS Enhancer применяется не только для  коррекции семейных снимков  и   художественных фотографий,
программу используют  издатели и редакторы  технической литературы, чтобы представить иллюстрации
оборудования как можно более детально. В  медицине эта программа помогает при распознавании нечетких
рентгеновских снимков.

Программа позволяет сохранять свои любимые и наиболее часто используемые настройки как пресеты и вызывать их
по мере надобности, что облегчает и ускоряет работу. Enhancer поддерживает пакетную обработку файлов, что
делает возможным автоматическое редактирование большого количества  фотографий. Это очень полезно, когда
приходится иметь дело с однотипными дефектами, как чаще всего и бывает.
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AKVIS Enhancer представлен в виде плагина для графических редакторов (plugin)  и  в  виде  отдельной,
самостоятельной, программы (standalone).

Оба варианта работают во всех трех режимах, но в программу standalone  также  включены дополнительные
возможности редактирования фотографий: в закладке  Постобработка можно изменить  яркость, контрастность и
насыщенность изображения, произвести коррекцию по каналам.
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Плагин Enhancer совместим с самыми популярными графическими редакторами: AliveColors, Adobe Photoshop, Photoshop
Elements, Corel PaintShop Pro и Photo Paint и другими (смотрите список совместимых редакторов).

Тип лицензии определяет, какой именно вариант используется.
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УСТАНОВКА ПРОГРАММЫ
Установка программы под Windows (на примере AKVIS Enhancer)

Для установки программы на компьютер с системой Windows необходимо выполнить следующие действия:

Запустить программу установки двойным щелчком по файлу exe.
Выбрать язык программы и нажать на кнопку Установить (Install).
Ознакомиться с  Лицензионным Соглашением, при согласии с его условиями выбрать пункт "Я принимаю
условия лицензионного соглашения" ("I accept the term in the license agreement") и нажать на кнопку Далее
(Next).

Для установки  плагина нужно выбрать из списка графический редактор (или редакторы), в который будет
устанавливаться плагин.

Для установки  версии standalone (отдельной программы) должен быть выбран соответствующий вариант —
Standalone.
Для создания ярлыка программы на рабочем столе должен быть выбран компонент Ярлык на рабочий стол
(Desktop Shortcut).

Нажать на кнопку Далее (Next).

Нажать кнопку Установить (Install).
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Запустится процесс установки программы.

Можно подписаться на рассылку AKVIS и получать новости об обновлениях программ, ссылки на обучающие
статьи и специальные предложения. Для этого введите свой адрес e-mail и подтвердите согласие с политикой
конфиденциальности.
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Нажать кнопку Готово (Finish) для выхода из программы инсталляции.

После установки программы AKVIS Enhancer в главном меню Start (Пуск) появится пункт AKVIS -> Enhancer, a на
рабочем столе — ярлык программы AKVIS Enhancer (если при установке было выбрано создание ярлыка).

После установки плагина Enhancer в меню фильтров (эффектов) редактора появится новый пункт AKVIS – Enhancer.
Используйте эту команду для вызова плагина из графического редактора. Например, в Photoshop выберите: Filter ->
AKVIS -> Enhancer.

Внимание! Если плагин не установился в графический редактор автоматически, можно подключить его вручную. 
Обычно достаточно просто скопировать файл 8bf из папки AKVIS в папку Plug-ins графического редактора. Например,
для Adobe Photoshop CC скопируйте 8bf в папку Program Files\Common Files\Adobe\Plug-Ins\CC. 
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УСТАНОВКА ПРОГРАММЫ

 

Установка программы на Mac (на примере AKVIS Enhancer)

Для установки программы AKVIS на Mac выполните следующие действия:

Открыть виртуальный диск dmg:

- akvis-enhancer-app.dmg для установки версии Standalone (отдельной программы)

- akvis-enhancer-plugin.dmg для установки версии Plugin.

Ознакомиться с Лицензионным соглашением и нажать кнопку Agree.

Откроется окно Finder с приложением AKVIS Enhancer (в случае установки отдельной программы) или, в случае
установки плагина, с папкой AKVIS Enhancer PlugIn.

 

Приложение AKVIS Enhancer перетащите в папку Applications.

Папку AKVIS Enhancer PlugIn (целиком!) — в папку с плагинами графического редактора.

Например, для установки в редакторы Photoshop CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017
и CC 2015.5 перетащите плагин в папку Library/Application Support/Adobe/Plug-Ins/CC,

для установки в Photoshop CC 2015 — в Applications/Adobe Photoshop CC 2015/Plug-ins,

для установки в Photoshop CS6 — в Applications/Adobe Photoshop CS6/Plug-Ins.
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Плагины на Mac
(кликните на изображение для увеличения)

После установки  плагина Enhancer в меню фильтров (эффектов) редактора появится новый пункт  AKVIS –>
Enhancer. Используйте эту команду для вызова плагина из графического редактора. Например, в Photoshop выберите:
Filter -> AKVIS -> Enhancer.

Версия standalone (приложение) запускается обычным способом — двойным щелчком по файлу.

Также можно запустить программу AKVIS из приложения Фото, выбрав команду Изображение -> Редактировать в (в
High Sierra и более поздних версиях macOS).
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АКТИВАЦИЯ ПРОГРАММЫ

Внимание! Ваш компьютер должен быть подключен к сети Интернет.

Если подключение к Интернет недоступно, ниже предлагается альтернативный способ активации.

 

Скачать установочный файл AKVIS Enhancer (на странице программы или на странице загрузки).

Запустить скачанный файл и установить программу, следуя подсказкам мастера установки.

Запустить установленную программу. Окно О программе всегда показывается при запуске незарегистрированной
копии программы. Кроме того, окно  О программе выводится при нажатии кнопки   на Панели управления

программы.

При работе с плагином в редакторе Adobe Photoshop окно О программе может быть вызвано на экран выбором
команды меню Help -> About Plug-In –> Enhancer на Windows, Photoshop -> About Plug-In –> Enhancer на Mac.

 

При нажатии кнопки Попробовать откроется окно, где можно выбрать тип лицензии для ознакомления. Если пробный
период истёк, кнопка будет неактивна.

В течение ознакомительного периода (10 дней) доступна любая лицензия: Home (Plugin либо Standalone), Deluxe или
Business. При выборе лицензии рядом будет отображен пояснительный текст с кратким описанием данного типа
лицензии. В зависимости от выбора будут доступны разные возможности AKVIS Enhancer.

Для получения более полной информации о версиях и лицензиях программы AKVIS Enhancer смотрите сравнительную
таблицу.

 

При нажатии кнопки Купить будет открыто окно, где необходимо указать приобретаемый тип лицензии.

После выбора лицензии необходимо снова нажать кнопку Купить. В браузере откроется страница заказа, где можно
продолжить подбор программ либо приступить к оформлению покупки.

После заполнения формы и проведения денежной транзакции серийный номер будет выслан в течение нескольких
минут.

 

Чтобы зарегистрировать программу, нажать на кнопку Активировать. Откроется следующее окно:
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В поле Имя пользователя ввести имя, на которое будет зарегистрирована программа.

В поле Серийный номер ввести номер, полученный после оплаты заказа.

Ниже выбрать способ активации - через прямое соединение с сервером или через электронную почту.

Прямое соединение с сервером

Рекомендуется данный способ активации, как наиболее быстрый.

Компьютер должен быть подключен к сети Интернет.

Нажать на кнопку Активировать для завершения активации.

Отправить запрос по e-mail

Eсли был выбран способ активации через e-mail, то при нажатии на кнопку Активировать будет автоматически
создано письмо, которое, не редактируя, необходимо отправить по указанному адресу.

Если компьютер не подключен к Интернет, нужно записать созданное письмо на внешний носитель (диск или
"флешку") и отправить с другого компьютера, на котором есть доступ к сети. Все, что нам нужно, уже будет
записано в самом письме.

Если письмо не создается, просто пришлите нам серийный номер (код лицензии) программы и HardwareID (HWID)
компьютера, на котором установлена программа.

В ответ будет получено письмо с вложенным файлом  Enhancer.lic, который следует поместить в папку, где
хранится лицензионная информация о программе. Это папка AKVIS в Общих документах пользователей:

Windows 7, Windows 8, Windows 10:

Users\Public\Documents\AKVIS;

Mac:

Users/Shared/AKVIS или домашняя папка пользователя.

Активация программы завершена.
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При желании можно произвести апгрейд до версии Home Deluxe или Business, доплатив разницу в цене. Для этого в
окне О программе необходимо нажать кнопку Улучшить (в зарегистрированной версии появляется на месте кнопки
Купить).

В открывшемся окне выбрать желаемую лицензию и нажать кнопку  Улучшить. При этом в браузере откроется
страница заказа, где можно оплатить выбранный апгрейд.

После оплаты вы получите сообщение, что ваша лицензия обновлена, после чего потребуется переактивировать
программу.

При нажатии кнопки Отменить происходит возврат в окно О программе.

При возникновении вопросов или проблем обратитесь в службу поддержки - support@akvis.com.
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ОПИСАНИЕ РАБОЧЕЙ ОБЛАСТИ

AKVIS Enhancer может работать как отдельная программа или как плагин к графическому редактору.

Запустить отдельную программу можно следующими способами:

На компьютере с Windows - через меню Пуск либо с помощью одноименного ярлыка на рабочем столе;

На компьютере с Mac - из папки Applications.

Для вызова плагина необходимо открыть изображение в редакторе, а затем выбрать пункт AKVIS –> Enhancer из
меню фильтров.

 

Окно программы AKVIS Enhancer выглядит следующим образом:

 

Элементы окна программы:

Большую часть окна программы AKVIS Enhancer занимает Окно изображения с закладками До и После. В закладке
До находится исходное изображение, в закладке После - результат обработки. Переключаться между ними можно
щелчком левой кнопки мыши.

Настроить внешний вид Окна изображения и закладок можно с помощью кнопок, расположенных в нижней части
Панели инструментов.

 

В верхней части окна программы расположена Панель управления с кнопками:

Кнопка   позволяет перейти на домашнюю страницу программы AKVIS Enhancer.

Кнопка   (только в отдельной программе) предназначена для открытия изображения, которое будет

редактироваться. Открыть изображение можно с помощью сочетания клавиш Ctrl+O  на Windows, ⌘ +O  на Mac.

При щелчке правой кнопкой мыши будет показан список последних использованных файлов, сортированных по
времени открытия. Длина списка задаётся в окне изменения настроек программы.

AKVIS Enhancer
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Кнопка   (только в отдельной программе) предназначена для сохранения на диск отредактированного

изображения. Для сохранения изображения можно использовать сочетание клавиш  Ctrl+S  на Windows,  ⌘ +S

на Mac.
Кнопка   (только в отдельной программе) предназначена для вывода изображения на печать. Для вызова

диалога печати можно использовать сочетание клавиш Ctrl+P  на Windows, ⌘ +P  на Mac.
Кнопка   позволяет опубликовать результат на своей странице в социальной сети.

Кнопка   предназначена для загрузки сохраненных ранее пресетов из файла с расширением .enhancer.

Кнопка   предназначена для записи пресетов в отдельный файл с расширением  .enhancer. В файл можно

сохранить любое количество пресетов.
Кнопка   (только в отдельной программе) вызывает диалоговое окно пакетной обработки фотографий.

Кнопка   (в режимах Допечатная обработка и Тоновая коррекция) запускает процесс обработки всего

изображения.
Кнопка   (только в плагине) предназначена для применения результатов и закрытия окна плагина  AKVIS

Enhancer.
Кнопка   предназначена для вызова сведений о программе.

Кнопка   (либо клавиша F1 ) предназначена для вызова справки помощи по программе.

Кнопка   вызывает диалог изменения Настроек программы.

Кнопка   вызывает панель оповещений со свежими новостями о программе.

 

Слева от Окна изображения находится Панель инструментов c вспомогательными инструментами:

Кнопка   (в режимах  Допечатная обработка  и   Тоновая коррекция) включает и выключает  окно

предварительного просмотра.
Кнопка   (только в отдельной программе) активирует инструмент  Кадрирование. С помощью данного

инструмента можно отсечь часть изображения, оставив нужный фрагмент.
Кнопка   активирует инструмент Рука, который позволяет двигать фотографию, когда она не помещается в

Окне изображения при выбранном масштабе. Для перемещения необходимо нажать на кнопку, подвести курсор
к изображению и, удерживая левую кнопку мыши нажатой, передвинуть в нужную сторону.
Двойным щелчком по кнопке   изображение масштабируется под размер окна программы.

Кнопка   активирует инструмент  Лупа, предназначенный для изменения масштаба изображения. Для

увеличения масштаба необходимо щёлкнуть левой кнопкой мыши по изображению в окне программы. Для
уменьшения масштаба изображения щелчок производится с нажатой клавишей Alt .

Двойным щелчком по кнопке   можно развернуть изображение в натуральную величину (100%).

Перемещение по изображению и масштабирование осуществляется с помощью Навигатора. Рамкой в Навигаторе
отмечена та часть изображения, которая в данный момент является видимой в  Окне изображения; области за
пределами рамки будут затенены. Рамку можно перетаскивать, меняя видимую часть изображения. Для перемещения
необходимо поместить курсор внутрь рамки и, удерживая левую кнопку мыши, выполнить перетаскивание.

Для прокрутки изображения в Окне изображения можно использовать полосы прокрутки или нажать на пробел и
перетаскивать изображение левой кнопкой мыши. Прокруткой колёсика мыши изображение можно перемещать вверх-
вниз, удерживая  Ctrl  на Windows,  ⌘  на Mac – вправо-влево, удерживая  Alt  на Windows,  Option  на  Mac −
масштабировать. При щелчке правой кнопкой мыши на полосе прокрутки появляется меню быстрых перемещений.

С помощью ползунка можно масштабировать изображение в Окне изображения. При перемещении ползунка вправо
происходит увеличение масштаба изображения; при щелчке по кнопке   или при перемещении ползунка влево
происходит уменьшение масштаба изображения.

Также масштаб изображения изменится, если ввести в поле масштабирования новый масштабный коэффициент. Часто
используемые масштабы помещены в выпадающее меню поля масштабирования.

Для увеличения масштаба изображения можно воспользоваться клавиатурными сокращениями: +  и Ctrl++  (⌘ ++  на
Mac); для уменьшения масштаба -  и Ctrl+-  (⌘ +-  на Mac).
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Под Навигатором расположена Панель настроек с параметрами выбранного режима обработки.

На панели Пресеты понравившиеся настройки программы можно сохранить как пресет и использовать в дальнейшем.

Внизу на Панели настроек выводится подсказка: краткое описание параметров и кнопок, на которые наведён курсор.
Изменить местоположение окна подсказки можно в Настройках программы.
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РЕЖИМЫ ПРОСМОТРА ИЗОБРАЖЕНИЯ

В нижней части Панели инструментов расположены три кнопки, отвечающие за внешний вид Окна изображения.

Кликом мыши по первой кнопке открывается вложенное меню, где представлены различные варианты просмотра
исходного и обработанного изображений:

- При выборе   отображается стандартное Окно изображения с закладками До и После.

- При нажатии на   или   Окно изображения разбивается на два окна (по вертикали и по

горизонтали соответственно). Часть исходного и часть обработанного изображения, видимые в окнах До  и
После, складываются вместе, образуя целую картинку.

При таком разбиении разделяющую линию можно двигать с помощью курсора мыши, изменяя соотношение
размеров окон До и После.

- При нажатии на   или   Окно изображения также делится пополам (по вертикали или по

горизонтали). В отличие от предыдущего разделения, здесь в каждом из окон отображается один и тот же
фрагмент изображения до и после обработки.

Примечание: Использовать различные режимы просмотра удобно в тех случаях, когда вы хотите увидеть и
сравнить фрагмент исходного и обработанного изображения на одном экране. Если же вы хотите взглянуть на
готовое изображение в целом, то лучше выбрать режим со стандартным Окном изображения.

При нажатии кнопки   закладки До и После поменяются местами.
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При выборе последней кнопки также откроется вложенное меню. Используя находящиеся в нем кнопки  , 

и  , можно изменить цвет фона Окна изображения на белый, серый или черный либо, нажав кнопку  ,

вызвать диалог Выбор цвета и выбрать цвет фона на свой вкус.
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РАБОТА С ПРОГРАММОЙ

AKVIS Enhancer может работать как отдельная программа или как плагин к графическому редактору.

Для обработки изображения необходимо выполнить следующие действия:

Шаг 1. Открыть изображение.

- В отдельной программе (файл в формате TIFF, BMP, JPEG, PNG или RAW):

Диалоговое окно  Открыть изображение можно вызвать  сразу после запуска программы с помощью
двойного щелчка мыши в области Окна изображения или кнопкой   на Панели управления. Кроме

того, можно перетащить ярлык изображения в открытое окно программы.

- При работе с плагином:

В графическом редакторе с помощью команды меню Файл -> Открыть или сочетания клавиш  Ctrl+O  на
Windows, ⌘ +O  на Mac вызвать диалог открытия изображения и выбрать требуемый файл.

Вызвать плагин AKVIS Enhancer с помощью команды меню:

в AliveColors: Эффекты -> AKVIS -> Enhancer; 
в Adobe Photoshop: Filter –> AKVIS –> Enhancer; 
в Corel Paint Shop Pro: Effects –> Plugins -> AKVIS –> Enhancer; 
в Corel Photo-Paint: Effects –> AKVIS –> Enhancer.

Шаг 2. Выбрать режим обработки изображения в выпадающем списке на Панели настроек.

Режим Улучшение деталей усиливает разницу между пикселами и позволяет проявить скрытые в снимке
дополнительные детали изображения. Его конек - детализация.

Режим Допечатная обработка позволяет провести быструю допечатную обработку изображения, сделать
его более четким и контрастным.

Режим  Тоновая коррекция выполняет тоновую коррекцию, позволяет сделать определенные цветовые
области темнее или светлее. Обработка идет не просто в тенях-свете, но в цветовых оттенках этих
областей, что позволяет улучшить изображение в выбранном диапазоне.

Сравнение работы режимов описано здесь.

Шаг 3. Настроить параметры выбранного режима на Панели настроек.
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Шаг 4. Понравившиеся настройки можно сохранить как пресет и использовать в дальнейшем. Для сохранения
настроек следует ввести имя пресета в поле Пресеты и нажать на кнопку Сохранить.

При перемещении курсора по списку готовых пресетов будет показан образец с примерным результатом
обработки.

Чтобы обработать изображение с помощью пресета, необходимо выбрать соответствующий пресет из списка, в
режимах Допечатная обработка и Тоновая коррекция после выбора пресета нажать на кнопку  .

Если значения параметров были изменены, то для того чтобы вернуть настройки пресета, необходимо нажать на
кнопку Сброс.

Для удаления пресета необходимо выбрать его из списка пресетов и нажать на кнопку Удалить.

Шаг 5. Выполнить дополнительную коррекцию изображения в закладке Постобработка.
Шаг 6. При желании можно опубликовать результат на своей странице в социальной сети.

В стандалон-версии AKVIS Enhancer есть возможность распечатать получившееся изображение.

Шаг 7. Сохранить получившееся изображение.
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- В отдельной программе:

Нажать на кнопку   и в диалоговом окне Сохранить изображение ввести имя файла, указать формат

(TIFF, PNG, BMP или JPEG) и выбрать каталог, в который необходимо сохранить файл.

- При работе с плагином:

Нажать кнопку  , чтобы применить результат обработки. Окно плагина AKVIS Enhancer закроется, и

изображение появится в окне графического редактора.

Вызвать диалог сохранения файла командой меню Файл -> Сохранить как, ввести имя файла, указать
формат и выбрать каталог, в который необходимо сохранить файл.
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Затемнение = 50 Затемнение = 400

ОБРАБОТКА ИЗОБРАЖЕНИЯ В РЕЖИМЕ УЛУЧШЕНИЕ ДЕТАЛЕЙ

В режиме Улучшение деталей можно проявить детали в светлых и темных областях изображения.

Результат коррекции в режиме Улучшение деталей

 

Чтобы обработать изображение в данном режиме, необходимо выполнить следующую последовательность действий:

На Панели настроек выбрать подходящее значение параметра Превью.

Параметр Превью является вспомогательным: он не влияет на истинный размер изображения и используется только
на стадии предварительной обработки для ускорения процесса подбора параметров коррекции.

При значении "Точно" - обработка будет происходить на изображении с исходными размерами, но более медленно. При
значении "Быстро" - размер превью будет меньше исходного изображения в 8 раз, соответственно уменьшится время
обработки, но результат получится примерным. При промежуточных значениях размер превью меньше оригинального
изображения в 2 и 4 раза.

Внимание! При использовании ускоренного расчета результат может немного отличаться от полученного при
полном расчете. Чтобы удостовериться в достижении нужного результата, рекомендуется хотя бы раз запустить
процесс обработки изображения со значением "Точно".

 

Отрегулировать значения параметров коррекции. Изменения будут применяться автоматически ко всему изображению
после настройки очередного параметра.

Затемнение (0-500). Параметр усиливает тени на изображении. При его увеличении темные участки становятся
еще темнее.

Осветление (0-500). Параметр позволяет осветлить изображение. При увеличении значения светлые участки
изображения становятся еще светлее.
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Осветление = 50 Осветление = 400

 

Насыщенность = -25

 

Насыщенность = 25

 

Градиентный контраст = 10

 

Градиентный контраст = 50

 

Степень детализации = 5

 

Степень детализации = 45

Насыщенность (-50..50). Параметр позволяет изменить интенсивность цветов изображения.

Градиентный контраст (0-50). Параметр отвечает за мягкое усиление контраста градиентных областей,
подчеркивает крупные детали, делает изображение более объемным.

Степень детализации (0-50). Параметр задает степень подчеркивания деталей. Чем больше значение
параметра, тем резче становятся контуры на изображении и тем сильнее проявляются детали.

Порог (1-10). Параметр определяет какие детали будут усиливаться при увеличении детализации. При малых
значениях параметра усиливаются все детали, при больших - незначительные детали не затрагиваются.
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Порог = 2

 

Порог = 10

 

Освещенность = 5

 

Освещенность = 20

Освещенность (0-20). Параметр поможет проявить детали в темных областях. При увеличении значения
параметра изображение становится светлее.
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Исходное изображение

 
Результат

ОБРАБОТКА ИЗОБРАЖЕНИЯ В РЕЖИМЕ ДОПЕЧАТНАЯ ОБРАБОТКА

При печати фотографий иногда возникает ситуация, когда контуры объектов на бумаге выглядят нечеткими, хотя на
экране монитора они казались безупречными. Чтобы этого не произошло, следует предварительно обработать
изображение. Используйте режим Допечатная обработка для увеличения резкости границ и контрастности всего
изображения перед печатью.

Кроме подготовки изображения к печати, режим можно использовать для улучшения фотографий, например, перед тем
как выкладывать их в сети.

Чтобы обработать изображение в данном режиме, необходимо выполнить следующую последовательность действий:

Шаг 1. После выбора режима в закладке До появится область предварительного просмотра.

Область предварительного просмотра - это квадрат с контуром в виде "бегущей" пунктирной линии, в
котором отображается результат обработки изображения с учетом изменения настроек. Этот квадрат можно
просто перетащить (щелкнув и удерживая левую кнопку мыши) или нарисовать заново (двойной щелчок левой
кнопкой мыши) в любой части изображения, анализируя тем самым разные участки фотографии.

Щёлкнув и удерживая левую кнопку мыши внутри окна предварительного просмотра, можно сравнить исходное
изображение с результатом обработки в области предварительного просмотра.

Шаг 2. Отрегулировать значения параметров коррекции:

Блок параметров Резкость позволяет сделать изображение более резким, детали на нем более отчетливыми.
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Радиус (1-100). Параметр определяет ширину зоны увеличения контраста вдоль границ объектов.
Значительное увеличение параметра может привести к появлению ореолов.

Степень усиления (0-100). Параметр регулирует степень усиления контраста вдоль границ объектов. При
увеличении параметра изображение становится более четким. Зависит от параметра Радиус.

Блок параметров Контрастность используется для усиления контраста изображения, за счет еще большего
осветления светлых участков и затемнения темных.

В темном (-50..100). Параметр усиливает тени на изображении. При его увеличении темные участки
становятся еще темнее, при уменьшении светлеют.

В светлом (-50..100). При перемещении движка вправо от 0 светлые участки изображения становятся еще
светлее. При перемещении влево увеличивается количество серых тонов.

Шаг 3. Для обработки изображения полностью нужно нажать кнопку  .
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ОБРАБОТКА ИЗОБРАЖЕНИЯ В РЕЖИМЕ ТОНОВАЯ КОРРЕКЦИЯ

Режим Тоновая коррекция предназначен для тоновой коррекции изображения, то есть изменения яркости пикселов в
темных и светлых областях, за счет которого улучшается общая картина. Коррекции может быть подвержено как все
изображение, так и только отдельные области, содержащие в себе выбранные для коррекции цвета.

Результат коррекции в режиме Тоновая коррекция

 

Чтобы обработать изображение в данном режиме, необходимо выполнить следующую последовательность действий:

Шаг 1. Сразу после перехода в этот режим в закладке До появится область предварительного просмотра.

Область предварительного просмотра - это квадрат с контуром в виде "бегущей" пунктирной линии, в
котором отображается результат обработки изображения с учетом изменения настроек. Этот квадрат можно
просто перетащить (щелкнув и удерживая левую кнопку мыши) или нарисовать заново (двойной щелчок левой
кнопкой мыши) в любой части изображения, анализируя тем самым разные участки фотографии.

Щёлкнув и удерживая левую кнопку мыши внутри окна предварительного просмотра, можно сравнить исходное
изображение с результатом обработки в области предварительного просмотра.

Шаг 2. Выбрать цвета, которые будут корректироваться. Для этого использовать Цветовые наборы. Исходный
набор состоит из семи цветов. Ниже расположены два дополнительных пустых набора с тремя ячейками в
каждом. Цвета из основного набора можно перемещать в эти ячейки. В итоге, посредством перетаскивания
красок, можно получить от одного до трех наборов цветов. Для переключения с одного цветового набора на
другой необходимо щелкнуть левой кнопкой мыши по нужному из трех. Выбранный цветовой набор выделяется
более светлым цветом.
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Формирование цветовых наборов значительно упрощает Цветовой индикатор, расположенный над наборами
цветов.

Для каждой точки изображения автоматически определяются 1-3 основных цветовых составляющих. При
наведении курсора мыши на изображение эти цвета будут мгновенно отображены на Цветовом индикаторе. В
соответствии с показаниями индикатора возможно наиболее точно подобрать нужный  Цветовой набор для
редактируемой области.

Шаг 3. Отрегулировать значения параметров коррекции (для каждого набора цветов параметры
регулируются отдельно, выбранный набор выделяется более светлым цветом):

Радиус (1-60). Параметр определяет для каждой точки изображения окрестность, подлежащую анализу. В
результате анализа точке присваиваются новые цвет и яркость, которые определяют принадлежность
точки одному из цветовых наборов. После этого точка подвергается дальнейшей обработке.

Темные области (0-100). По умолчанию параметр имеет нулевое значение и коррекции темных областей
не происходит. При увеличении значения данного параметра темные области изображения становятся
светлее, в них начинают проявляться неразличимые до этого детали.

Светлые области (0-100). По умолчанию параметр имеет нулевое значение и коррекции светлых областей
не происходит. При увеличении параметра светлые области изображения становятся темнее, повышается
их контрастность, объекты приобретают рельефность, за счет чего общая картина на изображении
становится более объемной и четкой.

Примечание: Для цветов, не принадлежащих одному цветовому набору, параметры обработки
смешиваются. Например, если красный и желтый цвета находятся в разных наборах, то для оранжевого
цвета коррекция будет происходить с учетом параметров обоих наборов.

Шаг 4. Для обработки изображения полностью нужно нажать кнопку  .
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До постобработки

 
После постобработки

ПОСТОБРАБОТКА

Выполнить дополнительную коррекцию изображения можно в закладке Постобработка с помощью гистограммы  и
нескольких параметров.

Закладка Постобработка доступна только в отдельной программе, т.к. содержит стандартные возможности, которые
можно найти в любом графическом редакторе.

Гистограмма – это график распределения тонов в изображении, по оси абсцисс откладываются числовые значения
яркости, а по оси ординат – число точек изображения, имеющих данную яркость.

Под гистограммой расположено три ползунка, которые можно двигать, меняя контрастность изображения, а также поля
ввода значений яркости.

Правый край гистограммы — это точка максимальной яркости (белый цвет). Этой точке соответствует белый ползунок.
Если гистограмма не дотягивает до правого края, значит, на изображении нет белых точек. Для того чтобы они
появились, необходимо переместить ползунок влево. Точки, до которых был перемещен белый ползунок, станут
абсолютно белыми (яркость 255), а яркости всех остальных точек будут пересчитаны. Само изображение будет
светлее.

Левый край гистограммы – это точка минимальной яркости (черный цвет). Этой точке соответствует черный ползунок.
Если гистограмма начинается не у самого левого края, значит, на изображении нет абсолютно черных точек (с
яркостью 0), поэтому черный ползунок необходимо передвинуть вправо. В результате самый темный тон с изображения
станет черным, все остальные уровни будут пересчитаны, а само изображение будет темнее.

Ползунок посередине гистограммы определяет, какой тон на изображении считается средне-серым (имеет яркость
128). Этот ползунок тоже можно двигать: при перемещении влево происходит осветление средне-серых цветов, при
перемещении вправо – затемнение.

Над гистограммой расположен выпадающий список со значениями:  В цвете (статистика по всем трем каналам,
наложение графиков),  Красный, Зеленый, Синий, RGB (сумма значений всех трех каналов),  Яркость (средняя
яркость).

Коррекцию можно осуществить избирательно по отдельным каналам или по обобщенному каналу RGB.

 

Задача остальных параметров в закладке  Постобработка - выполнить коррекцию яркости и контрастности
изображения, а также произвести гамма-коррекцию и изменить насыщенность цветов.

Яркость (-100..100). Параметр позволяет изменить яркость изображения. При увеличении значения параметра
все точки изображения становятся светлее, при уменьшении – темнее.
Контрастность (-100..100). Параметр позволяет увеличить (при задании значения больше 0) или уменьшить (при
задании значения меньше 0) разницу между яркими и темными участками изображения.
Гамма (50..250). Параметр позволяет управлять контрастом изображения за счет увеличения или уменьшения
полутонов и тонов серого среднего уровня.
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Насыщенность (-100..100). Параметр позволяет изменить интенсивность цветов изображения.
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ПАКЕТНАЯ ОБРАБОТКА ФОТОГРАФИЙ

В программе  AKVIS Enhancer существует возможность редактирования серии фотографий с помощью пакетной
обработки файлов.

Пакетная обработка реализована для всех режимов программы и может быть полезна при коррекции большого
количества фотографий, сделанных в одинаковых условиях с одними и теми же настройками фотоаппарата.

 

Подробная инструкция по работе с отдельной программой находится здесь.

Узнать о работе с плагином можно по ссылке.
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НАСТРОЙКИ ПРОГРАММЫ

Диалог изменения настроек программы вызывается кнопкой   и имеет вид:

Язык программы. Для переключения интерфейса программы на другой язык необходимо выбрать язык из
выпадающего списка.
Масштаб интерфейса. В списке можно выбрать размер элементов интерфейса. При выборе значения  Авто
масштаб интерфейса автоматически подстраивается под разрешение экрана.
Интерфейс. Переключаясь между цветами, можно выбрать стиль оформления программы - светлый или темный.
Масштаб изображения при загрузке. Возможны следующие варианты:

- изображение масштабируется Под размер окна. Масштаб подгоняется так, чтобы оно было полностью
видимым в Окне изображения;
- при значении параметра 100% изображение не масштабируется. В большинстве случаев при открытии в
масштабе 100% в окне программы будет показана лишь часть изображения.

Величина области просмотра (в пикселах). Размер Окна предварительного просмотра может меняться от
300х300 до 1000х1000 пикселов. Опция реализована в режимах Допечатная обработка и Тоновая коррекция.
Последние открытые файлы. Количество файлов, отображаемых в списке недавно открытых документов при
правом клике мышью по кнопке   (сортированы по времени открытия). Максимальная длина списка - 30

файлов.
Отображение подсказок. В данном блоке задаётся местоположение окна подсказок.

- Слева под окном изображения;
- Справа на панели настроек;
- Не отображать.

Чек-бокс  Закрепить панель управления блокирует возможность сворачивания панели. Разблокированную
панель можно сворачивать и разворачивать щелчком по маленькой треугольной стрелке. Свёрнутая панель
всплывает при наведении курсора.
Чек-бокс Использовaть GPU позволяет ускорить вычисления за счёт использования графического процессора.

Для принятия изменений в окне Настройки нажмите ОК.

При необходимости можно вернуть исходные значения параметров, нажав на кнопку По умолчанию.
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ПЕЧАТЬ ИЗОБРАЖЕНИЙ

Режим  Печать отвечает за подготовку изображений к распечатке на принтере. Перейти в режим печати можно
нажатием кнопки   на Панели управления.

Режим печати

Настроить печать выбранной фотографии можно с помощью параметров на Панели настроек:

В первом блоке из списка доступных принтеров выбрать нужный и указать необходимое разрешение, а также
задать количество печатных копий.

В блоке  Ориентация страницы задать положение листа при печати:  Альбомная  -  лист расположен
горизонтально или Книжная - лист расположен вертикально.

При нажатии на кнопку Параметры страницы открывается диалоговое окно, в котором можно выбрать размер и
ориентацию бумаги при печати, а также задать ширину полей печати.

Нажатием кнопки Сброс полей можно вернуть полям страницы исходные размеры.

В следующем блоке можно настроить размер изображения для печати с помощью параметров  Масштаб,
Ширина, Высота и Под размер страницы. Они не влияют на изображение, а только на его печатную копию.
Изменить размер печатной копии можно либо указав Масштаб изображения в %, либо задав новые значения для
параметров Ширина и Высота.

Чтобы распечатать изображение во всю страницу, следует выбрать чек-бокс Под размер страницы. Если чек-
бокс неактивен, то положение картинки можно задать с помощью стрелок справа или перетаскиванием мышью.

В блоке Рамка можно задать ширину и цвет рамки вокруг изображения.

В блоке Цветной фон с помощью цветовой пластины можно вызвать стандартный диалог выбора цвета и задать
цвет страницы.

В закладке  Страница можно настроить расположение одной или нескольких копий изображения на одной
странице.
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Печать страницы
С помощью параметра Копии указать количество копий обработанной фотографии на одной странице.
Параметрами  По горизонтали  и   По вертикали задать количество строк и столбцов для размещения
фотографий.
С помощью параметра Отступ задать ширину отступа между копиями фотографий.

На вкладке Постер можно настроить печать одного изображения на нескольких страницах для последующего
объединения в одно большое полотно.

Печать постера
Чек-бокс Страницы. При активном чек-боксе в поле справа можно задать количество страниц, на которое
будет поделена фотография. Масштаб изображения изменится, чтобы максимально заполнить все страницы.
При неактивном - программа автоматически подберет оптимальное число листов в соответствии с
фактическим размером изображения (масштаб = 100%).
Чек-бокс Поля для клея. При активном чек-боксе в поле справа можно задать ширину отступов для
склеивания листов. Отступы будут оставлены с правого и нижнего краев при печати страницы.
Чек-бокс Нумерация страниц. При активном чек-боксе на полях страницы будет напечатан номер ее
позиции в столбце и строке.
Чек-бокс Линии отреза. При активном чек-боксе на полях страниц будут напечатаны линии, по которым
можно отрезать лишние части распечатанных листов.

Для печати изображения с учетом настроенных параметров нажать на кнопку Печать. Для выхода из режима печати
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Для печати изображения с учетом настроенных параметров нажать на кнопку Печать. Для выхода из режима печати
нажать на кнопку Отмена.

При нажатии кнопки  Опции... будет открыт системный диалог, где можно произвести расширенную настройку и
отправить документ на печать.
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Исходное изображение

 
Результат

КЛУБНИЧНЫЙ МИКС

Режим Тоновая коррекция программы AKVIS Enhancer удобно применять в тех случаях, когда нужно усилить или
ослабить яркость определенного цвета или оттенка на изображении.

 

Для демонстрации возьмем следующее изображение.

Сначала попробуем усилить цвет ягод. Для этого из исходного цветового набора выбираем красный цвет и переносим
его в один из пустых наборов.

Выбранный набор будет выделен подсветкой. На Панели настроек увеличим значение параметра  Радиус до 45, а
параметра Светлые области до 70.  В результате получим более насыщенный и темный цвет ягод. При этом цвет
листьев останется без изменений.

А теперь сделаем темнее цвет листьев. Выберем в исходном наборе зеленый цвет и перенесем его в оставшийся
пустой набор.
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Для зеленого цвета увеличим значение параметра Светлые области до 90.

Нажмем кнопку  , чтобы применить настройки ко всему изображению. В результате цвет листьев также стал темнее

и насыщеннее, а изображение в целом выглядит более естественным.

Вот таким образом, усиливая или ослабляя разные цвета на изображении можно получать различные и достаточно
неплохие результаты.
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Исходное изображение Результат

КУБИКИ ЛЬДА

Если после печати фотография выглядит недостаточно четкой, не спешите отправлять ее в корзину. Воспользуйтесь
программой  AKVIS Enhancer в  режиме  Допечатная обработка. Любое изображение станет более четким и
контрастным всего за пару минут работы.

Для обработки возьмем вот эту фотографию кубиков льда. Выглядит неплохо, но не оставляет ощущение, что
смотришь на нее через запотевшее стекло.

Щелкните по изображению, чтобы открыть его в большем размере
Шаг 1. Запустим программу AKVIS Enhancer и откроем исходное изображение. Из списка режимов выберем
Допечатная обработка.

Шаг 2. В Области предварительного просмотра увидим результат с настройками по умолчанию. Изображение
стало более четким. Продолжим регулировать настройки, чтобы добиться лучшего результата.

Шаг 3. Все, что осталось сделать, это нажать на кнопку  , чтобы применить настройки ко всему

изображению.

В результате рисунок стал настолько четким, что видно мельчайшие капельки воды, а лед выглядит так
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натурально, что хочется его потрогать.

Щелкните по изображению, чтобы открыть его в большом размере
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До применения

 

После применения

ДОБАВИМ СВЕТА В ГОРОДСКОЙ ПЕЙЗАЖ

Очень часто в условиях уличной съемки при недостаточном освещении фотография получается слишком темной, и как
раз именно объект съемки оказывается плохо различим. В этом случае с помощью программы AKVIS Enhancer можно
"вытащить" детали из затемненных областей изображения.

Мы используем плагин AKVIS Enhancer, однако такую же фотокоррекцию можно выполнить и в отдельной программе
(в режиме Улучшение деталей).

Шаг 1. Откроем в редакторе исходное изображение.

Шаг 2. Вызовем плагин AKVIS Enhancer. Для этого в редакторе AliveColors необходимо выбрать пункт меню
Эффекты -> AKVIS -> Enhancer, в Adobe Photoshop - пункт меню Filter -> AKVIS -> Enhancer, в Corel Paint
Shop Pro - пункт меню Effects -> Plugins -> AKVIS -> Enhancer.

Изображение будет обработано с параметрами по умолчанию.
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Шаг 3. Так как фотография затемнена, то детали проявлять сильнее необходимо в темных областях
изображения, поэтому увеличим значение параметра Освещенность, а также настроим остальные параметры
так, чтобы сделать изображение более светлым и четким.

Шаг 4. Нажмем на кнопку   на Панели управления, чтобы применить результаты редактирования и закрыть

окно плагина.
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ПРОГРАММЫ КОМПАНИИ АКВИС

 

AKVIS AirBrush — Аэрографический рисунок из фотографии

AKVIS AirBrush позволяет превратить фотографию в рисунок в технике  аэрография. Программа действует как
художественный фильтр, изменяя изображение и превращая его в аэрографический рисунок в соответствии с
выбранными настройками. Подробнее…

 

AKVIS Artifact Remover AI — Улучшение качества сжатых изображений JPEG

AKVIS Artifact Remover AI — бесплатная программа для улучшения качества сжатых изображений. Программа
использует алгоритмы искусственного интеллекта для удаления артефактов JPEG, уменьшения шума и пикселизации.
Подробнее…

 

AKVIS ArtSuite — Эффекты и рамки для фотографий

AKVIS ArtSuite — коллекция рамок и эффектов для оформления фотографий. ArtSuite содержит множество готовых
шаблонов и богатую Библиотеку образцов и текстур и позволяет получить практически бесконечное количество
вариантов эффектов. Подробнее…
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AKVIS ArtWork — Имитация художественных стилей

AKVIS ArtWork имитирует художественные стили и техники живописи, создавая произведение искусства. В программе
представлены эффекты:  Масляная живопись, Акварель, Гуашь, Комикс, Перо и чернила, Линогравюра, Пастель  и
Пуантилизм. Подробнее…

 

AKVIS Chameleon — Создание коллажей

AKVIS Chameleon — программа для создания коллажей, реалистичных и фантастических. Chameleon экономит время и
силы, так как не требует точного выделения объектов,  автоматически сглаживает границы и подбирает цветовую
гамму "вставки" к цветам фона. Подробнее…
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AKVIS Charcoal — Рисунок углем и мелом

AKVIS Charcoal позволяет преобразовать фотографию в рисунок, выполненный углём и мелом. Изменяя цвета
материалов и бумаги, можно получить массу самых разнообразных эффектов, например, рисунок сангиной.
Подробнее…

 

AKVIS Coloriage — Раскрашивание изображений

AKVIS Coloriage позволяет раскрашивать черно-белые фотографии и заменять цвет на цветных изображениях,
выполнять выборочное раскрашивание и обесцвечивание. С помощью программы можно вернуть к жизни старые снимки
и придать современной фотографии винтажный вид. Подробнее…

 

AKVIS Decorator — Замена текстуры и перекраска поверхности

AKVIS Decorator — программа для изменения поверхности объекта. Decorator позволяет заменить текстуру либо цвет
выбранного объекта. При наложении текстуры сохраняется объем, изгибы, тени исходного изображения. В программе
представлена богатая Библиотека текстур:  образцы поверхностей дерева, металла, камня, травы, тканей и др.
Подробнее…
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AKVIS Draw — Создание карандашного эскиза

AKVIS Draw позволяет превратить фотографию в эскиз, выполненный простым карандашом. Программа имитирует
видение и подход истинного художника. С помощью AKVIS Draw вы можете придать любому изображению вид быстрого
карандашного наброска. Подробнее…

 

AKVIS Enhancer — Фотокоррекция с усилением детализации

AKVIS Enhancer — программа для обработки фотографий с усилением детализации изображения. Программа позволяет
проявить детали в светлых и темных областях, улучшить резкость и контрастность изображения, добавить яркость,
отредактировать отдельные цветовые области. Программа работает в трех режимах: Улучшение деталей, Допечатная
обработка и Тоновая коррекция. Подробнее…

 

AKVIS Explosion — Эффекты разрушения и распада

AKVIS Explosion добавляет на фотографии эффекты разрушения. Программа позволяет распылить объект на осколки,
превратить часть изображения в россыпь летящих частиц, создать песчаную бурю, имитировать взрыв и другие
эффекты распада. Подробнее…
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AKVIS Frames — Готовые рамки для фотографий

AKVIS Frames — бесплатная программа для оформления фотографий. Программа предназначена для работы с
пакетами рамок AKVIS. Вы можете украсить свои снимки эксклюзивными стильными рамками! Подробнее…

 

AKVIS HDRFactory — Расширение динамического диапазона

AKVIS HDRFactory — программа для создания изображений с расширенным динамическим диапазоном (HDR) из одного
или нескольких снимков, а также для коррекции яркости, контрастности, насыщенности. HDRFactory наполнит жизнью
и цветом ваши фотографии! Подробнее…

 

AKVIS LightShop — Световые и звездные эффекты

AKVIS LightShop добавляет световые эффекты на изображение. С помощью программы можно создать любого вида и
формы свечения, добавить на фотографию лучи, ореолы, вспышки, молнии, блики на объекты, закат или фейерверк.
LightShop украсит снимок, оживит пейзаж, изменит время суток и погоду. Подробнее…
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AKVIS Magnifier AI — Увеличение и уменьшение изображений

AKVIS Magnifier AI изменяет размер изображения без потери качества. Благодаря использованию нейросетей
программа обеспечивает многократное увеличение и создает изображения высокого разрешения и постеры огромных
размеров. Подробнее…

 

AKVIS MakeUp — Ретушь портретных фотографий

AKVIS MakeUp — программа для исправления портретных фотографий. MakeUp улучшает портрет, устраняя мелкие
дефекты с поверхности кожи и придавая лицу сияние, чистоту и гладкость. Программа способна превратить обычный
снимок в фотографию с обложки, создать стильный образ и даже получить изображение в "высоком ключе".
Подробнее…

 

AKVIS NatureArt — Природные явления на ваших фотографиях
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AKVIS NatureArt — коллекция уникальных эффектов, имитирующих природные явления. В программу включены
эффекты: Дождь

 

AKVIS Neon — Рисунок светящимися линиями

AKVIS Neon превращает фотографию в яркий и необычный рисунок, выполненный светящимися линиями. Программа
предназначена для создания неоновых эффектов на изображении. Подробнее…

 

AKVIS Noise Buster AI — Удаление цифрового шума

Noise Buster AI — программа для подавления цифрового шума. Программа убирает шумы матрицы цифровой камеры и
шумы, появляющиеся при сканировании фотоснимка, уменьшает зернистость и устраняет неоднородные цветовые
пятна на изображении, сохраняя при этом детали и чёткость границ. Программа использует технологии искусственного
интеллекта и настройки постобработки для усовершенствования результата. Подробнее…
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AKVIS OilPaint — Эффект масляной живописи

AKVIS OilPaint — программа для имитации масляной живописи. Особенностью программы является уникальный
алгоритм наложения мазков, который наиболее достоверно воспроизводит технику работы кистью. Подробнее…

 

AKVIS Pastel — Рисунок пастелью из фотографии

AKVIS Pastel позволяет преобразовать обычный фотоснимок в рисунок, выполненный пастелью. Программа превращает
любое изображение в произведение искусства, имитируя одну из самых популярных художественных техник,
обладающую графическими и живописными свойствами. Подробнее…

 

AKVIS Points — Картины в технике пуантилизма

AKVIS Points превращает фотографии в картины в одной из самых выразительных живописных техник — пуантилизм. С
помощью программы Points вы с легкостью можете создавать великолепные произведения искусства в манере
пуантилистов. Откройте для себя мир ярких красок! Подробнее…
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AKVIS Refocus AI — Улучшение фокусировки, эффекты размытия

AKVIS Refocus AI повышает резкость нечетких фотографий, предлагает полную и выборочную фокусировку, добавляет
эффекты размытия и боке. Программа работает в пяти режимах:  Исправление фокуса AI, Миниатюра, Размытие
диафрагмы, Размытие движения и Радиальное размытие. Подробнее…

 

AKVIS Retoucher — Восстановление и ретушь фотографий

AKVIS Retoucher — программа для восстановления изображений и ретуши фотографий.

Программа поможет удалить царапины, пятна, пыль, следы от сгибов и другие дефекты; убрать лишние детали, текст;
реконструировать недостающие части фотографии, "затянуть" дырявые места и нарастить оборванные края.
Подробнее…
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AKVIS Sketch — Рисунок карандашом из фотографии

AKVIS Sketch — программа для создания рисунка из фотографии. Программа превращает фотоснимки в эскизы,
сделанные карандашом или углем, позволяет создать черно-белый карандашный набросок или цветной рисунок. В
программе представлены следующие стили: Классический, Художественный и Маэстро, — каждый с набором готовых
пресетов. AKVIS Sketch позволяет каждому почувствовать себя художником! Подробнее…

 

AKVIS SmartMask — Выделение объекта и удаление фона

AKVIS SmartMask — программа для быстрого выделения объектов на изображении. SmartMask позволяет быстро и
качественно вырезать часть фотографии, используется для удаления фона, создания коллажей. Подробнее…

 

AKVIS Watercolor — Рисунок акварельными красками

AKVIS Watercolor превращает фотографию в акварельный рисунок. Благодаря многообразию настроек можно
создавать картины в самых разных жанрах: от захватывающих морских пейзажей до нежных натюрмортов и изысканных
портретов. Подробнее…
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